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Copyright

The content of this document is confidential and intended for reading only by the addressee. All rights 

including Intellectual Property Rights flowing from, incidental to or contained in this document 

irrevocably vest in Emesent unless otherwise agreed to in writing.

©Emesent 2022

Using this manual

Hovermap is a powerful system that can be used as a LiDAR mapping payload, but also as an advanced 

autopilot for drones and other platforms. We therefore recommended that you read the user manual 

thoroughly to make use of all its capabilities in a safe and productive way.

Disclaimer and safety guidelines

This product is not a toy and must not be used by any person under the age of 18. It must be operated 

with caution, common sense, and in accordance with the instructions in the user manual. Failure to 

operate it in a safe and responsible manner could result in product loss or injury.

By using this product, you hereby agree that you are solely responsible for your own conduct while 

using it, and for any consequences thereof. You also agree to use this product only for purposes that 

are in accordance with all applicable laws, rules and regulations.

The use of Remotely Piloted Aircraft Systems (RPAS) may result in serious injury, death, or property 

damage if operated without proper training and due care. Before using an RPAS, you must ensure that 

you are suitably qualified, have received all necessary training, and read all relevant instructions, 

including the user manual. When using an RPAS, you must adopt safe practices and procedures at all 

times.
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Warnings

This document is legally privileged, confidential under applicable law and is intended only for the 

use of the individual or entity to whom it is addressed. If you have received this transmission in 

error, you are hereby notified that any use, dissemination, distribution or reproduction is strictly 

prohibited. If you are not the intended recipient, please notify the sender and delete the 

message from your system.

Do not attempt to disassemble, repair, tamper with, or modify the this product. This product 

contains no user-serviceable parts inside. Any disassembly of the product enclosure will 

invalidate the IP65 rating and disrupt the factory calibration of LiDAR. Contact Emesent for any 

repairs or modifications.

Always be aware of moving objects that may cause serious injury, such as spinning propellers or 

other components. Never approach a drone while the propellers are spinning or attempt to catch 

an airborne drone.
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FCC and IC regulatory information

Please note the following regulatory information related to the radios in the device.

Regulatory notes, statements, health and authorization for use

Radio frequency electromagnetic energy is emitted from radio devices. The energy levels of these 

emissions, however, are far less than the electromagnetic energy emissions from radio devices such as 

mobile phones. Radio devices are safe for use by consumers because they operate within the 

guidelines found in radio frequency safety standards and recommendations. The use of radio devices 

may be restricted in some situations or environments, such as:

On board an airplane

In an explosive environment

In situations where the interference risk to other devices or services is perceived or identified as 

harmful.

In cases in which the policy regarding use of radio devices in specific environments is not clear (for 

example in airports, hospitals, chemical/oil/gas industrial plants, private buildings), obtain authorization 

to use these devices prior to operating the equipment.

Regulatory information/disclaimers

Installation and use of this radio device must be in strict accordance with the instructions included in 

the user documentation provided with the product. Any changes or modifications made to this device 

that are not expressly approved by the manufacturer may void the user’s authority to operate the 
equipment. The manufacturer is not responsible for any radio or television interference caused by 

unauthorized modification of this device, or the substitution or attachment of connecting

cables and equipment other than those specified by the manufacturer. It is the responsibility of the 

user to correct any interference caused by such unauthorized modification, substitution or attachment.

The manufacturer and its authorized resellers or distributors will assume no liability for any damage or 

violation of government regulations arising from failure to comply with these guidelines. This device 

must not be co-located or operated in conjunction with any other antenna or transmitter.
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Federal Communications Commission and Industry Canada Compliance statement

This device complies with Part 15 of FCC rules and Industry Canada license exempt RSS standard(s). 

Operation is subject to the following two conditions:

This device may not cause interference.

This device must accept any interference, including interference that may cause undesired 

operation of this device.

Déclaration d’Industrie Canada

Cet appareil est conforme à la RSS concernant les appareils exempt s de licence par Industrie Canada. 

Son fonctionnement est soumis aux deux condition s suivantes :

cet appareil ne doit pas causer d’interférence nuisib le.

cet appareil doit accepter toutes les interférences reçues, y compris celles pouvan t causer un 

mauvais fonctionnement de l’appareil.

FCC interference statement

This equipment has been tested and found to comply with the limits for a Class B digital device, 

pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable protection against 

harmful interference when the equipment is operated in a commercial environment. This equipment 

generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance 

with the instruction manual, may cause harmful interference to radio communications. Operation of 

this equipment in a residential area is likely to cause harmful interference, in which case the user will 

be required to correct the interference at his own expense.

FCC radio frequency exposure statement

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment 

and meets the FCC radio frequency (RF) Exposure Guidelines. This equipment should be installed and 

operated keeping the radiator at least 20 cm or more away from person’s body.
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Déclaration d’Industrie Canada

Cet équipement est conforme aux limites d'exposition aux rayonnements de la FCC définies pour un 

environnement non contrôlé et aux directives d'exposition aux radiofréquences (RF) de la FCC. Cet 

équipement doit être installé et utilisé en gardant le radiateur à au moins 20 cm ou plus du corps de la 

personne

Export restrictions

This product or software contains encryption code which may not be exported or transferred from the 

US or Canada without an approved US Department of Commerce export license. Modifications not 

expressly authorized by manufacturer may invalidate the user’s right to operate this equipment.

Ce produit ou logiciel contient du code de chiffrement qui ne peut être exporté ou transféré du Canada 

ou des États-Unis sans un permis d’exportation du département du commerce des États-Unis. Toute 
modification n’ayant pas été expressément approuvée par la société peut annuler le droit de 
l’utilisateur de se servir du matériel.
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1. Licence Requirements

The Emesent Aura license uses the same physical USB key as our other software. Without a valid 

license, data processing is disabled. However, you can still access and modify your processed point 

cloud and GCP data.

•

•

The license is continually monitored while the software is used, make sure 

to keep it plugged in.

Click the License button in the top-right corner to view the license 

information. You will get a notification when your license is about to expire.
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2. System Requirements

Emesent Aura has the following system requirements:

Processor

Minimum: 10th Generation Intel Core i9 Processor

Recommended: 12th Generation Intel Core i9 Processor

RAM

Minimum: 64GB DDR4 3200Mhz Memory

Recommended: 128GB DDR5 4800MT/s Memory

Storage Drive

Minimum: 512GB Samsung 980 Pro NVME SSD

Recommended: 2TB Samsung 990 Pro NVME SSD

External Storage: High-speed USB 3.1 storage drive, with a minimum of 128 GB storage space 

for scan transfer from the Hovermap to a PC.

Graphics Card

Minimum: Nvidia RTX 3070 8GB Graphics Card

Recommended: Nvidia RTX 4070 Ti 12GB Graphics Card

Operating System: Windows 10 64-bit (x86)

Do not process scans on removable storage or network drives as it can lead to 

performance issues. To ensure faster processing without performance problems, 

scans must be downloaded and processed directly from your computer's main 

storage (SSD).
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1.

2.

3.

4.

5.

3. Getting Started with Emesent Aura

3.1 Step 1: Collect your data

Go to the following Knowledge Base articles for more information on how to perform your Hovermap 

scan:

The Hovermap workflow

Scanning techniques

The mission planning process

Once your scan is complete, download the raw Hovermap data onto a USB 3.0 storage device. You 

must copy this data from the USB drive to your local machine for processing.

3.2 Step 2: Install Emesent Aura

Download all files from the supplied USB flash drive, or our Software downloads page.

Run AuraInstall[version number].exe to begin the installation.

In the Emesent Aura setup wizard, click Next on each page to install the software. You must 

accept the end-user license agreement (EULA) to continue the installation.

In the Setup - Aura window, click Install.

On the final page, click Finish to complete the installation.

Scans from a Hovermap that use Emesent Cortex version 3.3 (or later) can only be 

processed in Aura 1.7 (or later).

Installing Emesent’s software requires administrator permissions. If you do not 
have these permissions contact your IT department or system administrator to 

install the software. Contact Customer Support if you have any issues.

https://4999118.hs-sites.com/en/knowledge/hovermap-start-up-and-led-color-guide
https://4999118.hs-sites.com/en/knowledge/scanning-techniques
https://4999118.hs-sites.com/en/knowledge/the-mission-planning-process
https://www.emesent.com/software-downloads/
https://emesent.com/customer-support/
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3.3 Step 3: Open Emesent Aura

To access all the features, you will need to upgrade your key. Without a valid license, data processing is 

disabled. However, you can still use the app to access and modify your processed point cloud and GCP 

data. Please contact Customer Support for more information on how to upgrade your license.

Figure 1 Emesent Aura UI

The license dongle can only be used on the same computer where Aura is 

installed. You will not be able to activate the license on a remote computer.

https://emesent.com/customer-support/
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•

For more information on each panel, go to the Emesent Aura UI section.

3.4 Step 4: Choose your settings

There are several global settings available that let you choose how you want to view and interact with 

your point clouds. Go to the Global Settings section for more information on each of these settings.

3.5 Step 5: Open a point cloud

There are three ways to open files in Emesent Aura.

In the top-left menu, click the Project Menu icon then select Open from the popup menu.

Drag and drop your file directly into the Viewport.

Go to the Visualize tab then click Add next to your chosen section.

1.

2.

3.

4.

5.

6.

7.

8.

Global Settings

Visualize Tab

Viewport

Process Tab

Main Toolbar

License and Software Version

Point cloud properties panel

Note: If the selected point cloud is georeferenced, this panel displays the 

number of points and other important information such as 

transformations, scaling, and offsets applied. It can be docked or made to 

float on the screen.

Context panel

Note: This panel is only visible once you have opened a point cloud. It also 

changes, depending on the selected data. It can be docked or made to float 

on the screen.

Press the F1 key in Aura at any time to access Help and see the full range of 

mouse actions and keyboard shortcuts available to you.
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The following file formats are supported:

LAS: Contains the point cloud. The industry-standard file format for LiDAR data.

LAZ: A compressed LAS file.

E57: A compact file format used for point cloud storage. Only E57 files generated by Emesent 

Aura are supported.

XYZ: A widely-supported point cloud format. In the context of Emesent Aura, XYZ files appear in 

the Entity panel as a trajectory point cloud, showing Hovermap’s path.

PLY: A standard mesh file format, which also serves as a supported format for point cloud data. 

When you click the Add button, the system automatically loads the PLY file into the appropriate 

section in the Visualize tab, regardless of the location. Currently, Emesent Aura does not offer 

the capability to generate PLY files; it only supports loading third-party-generated mesh PLY files.

The loading bar will show the loading progress of your point cloud file. If multiple files are loading 

simultaneously, there will be multiple loading bars (one for each file). The files are loaded in parallel 

with the smaller-sized files loading faster. There is no limit to the number of files that can be loaded at 

once but keep in mind that point clouds are loaded into your system’s memory and working with large 
datasets may affect your system’s performance.

•

•

Anti-virus software may conflict with Emesent’s software.

Installing Emesent’s software requires administrator permissions. If you do 
not have these permissions contact your IT department or system 

administrator to install the software. Contact Customer Support if you have 

any issues.

https://emesent.com/customer-support/
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1.

2.

3.

4.

5.

3.6 Step 6: Create your point cloud from raw data

To create a point cloud from your raw Hovermap data, you must process it first. There are several 

processing workflows available. To access these workflows, go to the Process tab then click Process 

Scan.

In the Configure New Scan Job panel, do the following:

Select any of the following workflows.

Process: Create a point cloud from your raw Hovermap data. For more information, go to 

the Process Workflow section.

GCP: Georeference your point cloud. For more information, go to the GCP Workflow section.

Merge: Merge multiple scans into one seamless point cloud. For more information, go to the 

Merge Workflow section.

Colorize: Augment your point clouds with true color. For more information, go to the 

Colorization Workflow section.

Extract 360 Images: Provide additional context to your point cloud by adding 360 

contextual reality to your Hovermap point cloud scans. For more information refer to the 

Emesent asset: 360 Panoramic Image Guide (includes video).

Convergence monitoring: Integrate the rapid data capture capabilities of the Hovermap 

with Aura's intuitive processing and analysis to help you manage and monitor your 

excavation projects. For more information, go to https://4999118.hs-sites.com/en/

knowledge/change-monitoring-and-change-detection-pdf.

Choose a profile for the selected workflow. This is a collection of settings designed to optimize 

processing for specific scenarios. For more information, go to the Processing Profiles section.

Click Processing Settings if you want to make changes to the default settings. Go to the Process 

Tab section for more information.

Click Start to begin processing. While processing, you can minimize the processing panel while 

simultaneously working on another point cloud.

Once processing is complete, click View to inspect and interact with your point cloud in the 

Viewport.

Although it is possible to process a scan that is on a shared network, it is not 

recommended as processing directly on the network will cause performance 

issues and problems with queuing jobs.

https://knowledge.emesent.com/360-panoramic-image-guide
https://4999118.hs-sites.com/en/knowledge/change-monitoring-and-change-detection-pdf
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3.7 Step 7: Clean up your point cloud

Cleaning up your point cloud after processing is essential for removing unwanted features and noise. 

To clean your point cloud, it's best to work in small sections. You can begin by using the SOR filter to 

eliminate noise. Once this is done, you can manually tidy up your point cloud using the tools available 

in the Main Toolbar.

For more information, go to the Cleaning your Point Cloud section.

3.8 Step 8: Measure your point cloud

There are several measuring tools available in the Main Toolbar. For more information on the tools 

available, go to Main Toolbar section.

3.9 Step 9: Create screenshots

Click Capture Screenshot to generate a screenshot of your current view. Your screenshot will be 

automatically saved in the Documents\Emesent\Aura\Screenshots folder. Click Open to open the 

folder containing your screenshot.

3.10 Step 10: Save your point cloud

From the Project Menu, click Save to save the changes to the existing file. Use Save As to create a copy 

of your point cloud with a different name, location, or file format.

Optionally, click Save Project in the Project Menu to preserve your current work for future 

modifications. The .aura project file serves as a starting point that can be reopened and edited 

whenever needed, allowing you to continue working on the project from where you left off.

Automated filtering can be integrated into the processing workflow. Go to 

Processing Settings then enable the cleaning filter(s) in the Point Filtering

section of the General tab.

We recommend that you avoid the use of special characters in your file names, as 

the software does not recognize them.
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4. Emesent Aura UI

4.1 Global Settings

These settings allow you to open and save files, open and save projects, set global preferences for 

viewing your point clouds, and capture screenshots. The following options are available.

4.1.1 Project Menu

Click the Project Menu icon on the top-left portion to access the following menu options.

Table 1 Project Menu Options

Menu Description

Open Opens a file and displays it in the viewport.

Open project Opens a previously saved .aura project file.

Save Saves the changes made to the current file.

Save as Creates a copy of your current file with a different name, location, or file format.

Save project Saves your current work for future modifications. The .aura project file serves 

as a starting point that can be reopened and edited whenever needed, allowing 

you to continue working on the project from where you left off.

Export reprojection Reprojects a previously processed/reprojected point cloud into a new 

coordinate reference system and GEOID model.
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4.1.2 Preferences

Click Preferences to see the global settings. Once you have configured the settings, click Save to apply 

the settings or Close to exit without saving. You can also click Reset Preferences to restore your 

preferences to their default settings.



Emesent Aura User Manual

Release date: 22 Apr 2025
Revision: 3.4

11

•

•

The following options are available.

Table 2 Preferences Settings

Field Data

Rendering

Point Budget The total number of points allowed in the Viewport. The upper limit can 

change, depending on the number of points available in your point cloud. 

With a large point cloud, you may not see every point on your screen 

unless you expand this setting to its upper limit.

Default setting: 7 million (for performance purposes)

Camera Type Perspective: Objects that are far away appear smaller than those 

that are closer. The Perspective view is easier on the eye because 

you use it in real life.

Orthographic: All objects appear at the same scale, giving a 

clearer measure of distances between objects and their relative 

size.

Default setting: Perspective

Near Clipping Plane Removes points from the Viewport that are closest to the camera. These 

points are not deleted, just not visible. This distance is configurable.

This feature is useful if you want to look at a cross-section of your point 

cloud or look through a wall.
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•

Field Data

Eye Dome Lighting (EDL) Enabled: Toggle on to enable eye dome lighting. This improves 

depth perception by shading the outline of points, accentuating the 

shape of each object. The point cloud can look a bit flat without 

this enabled.

Radius: The distance/thickness from the point being outlined. 

Setting the value to 1 outlines the pixels directly adjacent to the 

point, setting the value to 2 outlines the pixels 2 pixels away from 

the point and so on.

Bias: Controls the minimum depth difference between the points 

to be outlinde. Setting the value to 0 means that any difference in 

depth will get outlined, while a higher bias value (e.g. 1) means that 

only points that are at least 1 world space units apart will be 

outlined.

Strength: Changes the strength of the outline. A higher strength 

setting makes the outlines darker, mostly noticeable on surfaces.
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•

Field Data

Multi-Frame Rendering 

(MFR)
Enabled: Toggle on to enable multi-frame rendering screenshots, 

as well as the option to turn on live build-up. 

Default setting: Enabled

Live Build-up: Toggle on to enable the live build-up of the full 

point cloud in the viewport.

This setting allows you to navigate a dense point cloud more easily. 

MFR uses a lower point budget while navigating, but once you stop, 

it builds up to the full point budget available. This prevents lag and 

allows you to view your point cloud in detail. 

Default setting: Enabled

It will take a few seconds to create the screenshot 

with multi-frame rendering enabled.

•

•

•

•

MFR works best with the point size set to 0.

Setting the point budget too high with MFR 

enabled can result in poor responsiveness. 

The default value with MFR enabled is 3 

million.

Consider disabling MFR and increasing the 

point budget to 5 or 10 million when using 

point selection and measurement tools.

There are a number of triggers that initiate 

re-rendering, including translate/rotate, 

camera zoom/pan, undo/redo, and changes 

to file attributes (such as point shape, color 

scale, or point size).
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Field Data

View Defaults

Zoom Speed Fast: Good for wide, open scans.

Medium: Good for underground scans.

Slow: Good for close inspection.

Selection Outline Color Allows you to choose the color of the selection box using either the color 

picker or RGBA/HEX color codes.

•

•

You can only enable this setting if Multi-

Frame Rendering has been turned on.

We recommend that you don’t use MFR when 
using selection or measurement tools when 

aligning point clouds using translate/rotate 

tools or during the GCP constellation 

matching stage.
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Field Data

Appearance

Background Allows you to configure the background color of the viewport.

The standard black background means that you can miss a lot of detail, 

especially when viewing colorized point clouds. You can now change the 

background color to make this detail more visible.

None: No color selected. The background will be a standard black.

Solid: Allows you to choose a solid background color using either 

the color picker or RGBA/HEX color codes.

Gradient

Linear: Click the color at each end of the Gradient scale to 

choose a start and an end color. The gradient will be between 

these two colors. Move the Angle dial to change the angle of 

the gradient.

Corner: Allows you to specify individual colors for the top left, 

top right, bottom left, and bottom right of the Viewport.

Reset Preferences Reset all settings to the default.
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4.1.3 Capture Screenshot

Select Capture Screenshot to generate a screenshot of your current view. Your screenshot will be 

automatically saved in the Documents\Emesent\Aura\Screenshots folder.

If you have Multi-Frame Rendering enabled, a high-quality screenshot will be produced. All settings, 

such as GCP landmarks, will appear in the screenshot.

Click Open to open the folder containing your screenshot.

4.2 Visualize Tab

You can use the Visualize tab to see which files you have loaded into Emesent Aura. This tab is divided 

into three sections: Point clouds, GCPs, and Meshes.

Refer to the Getting Started with Emesent Aura section for instructions on how to open a file.
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4.2.1 Supported File Types

The file type determines which section in the tab your file appears in.

Point clouds: las, laz, e57, xyz, ply

GCPs: constellation.yaml

Meshes: ply

Table 3 Options

Button Name Action

Display Shows the file the in viewport. You can display multiple files at the same 

time.

Hide Hides the file in the viewport.

Remove Removes the file from Emesent Aura.

Focus Allows you to focus on this particular file in the viewport.

PLY is a standard mesh file format, which also serves as a supported format for 

point cloud data. Currently, Emesent Aura does not offer the capability to 

generate PLY files; it only supports the loading of third-party generated mesh PLY 

files.

Also, interaction for imported meshes is fairly limited. This will be improved in 

future releases.
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4.2.2 Moving the Panel

To move the panel containing the Visualize tab, hover over the upper left or right portion (depending 

on where it is located) until you see the Dock icon.

Click and hold the Dock icon then drag the panel to the left or right until you see a blue border to 

indicate that the panel will dock at that location once released.

Alternatively, you can make the panel float anywhere on the screen.
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4.3 Process Tab

You can use the Process tab to start a scan processing job (workflow) or view the Processing Queue.

4.3.1 Configure New Scan Job Panel

Clicking on Process Scan displays the Configure New Scan Job panel, which allows you to process a 

point cloud or GCP data. Once processed, enhance your scans using the Merge or Colorize features. 

You can then load these processed scans for editing in the Visualize tab.

For instructions on how to process a scan, refer to the Working with Point Clouds section.

Refer to the Visualize Tab section for docking instructions or making the panel 

float on the screen.
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4.3.2 Processing Queue

The Processing Queue lists all current, pending, failed, and completed workflows. The first section 

displays the overall percentage of completed workflows to those remaining in the queue.

4.3.2.1 Processing

All current and pending workflows are shown in the Processing section. Each workflow shows the 

folder name where the output files are saved. Clicking on View Workflow displays the progress of that 

particular workflow at the bottom.
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4.3.2.2 Completed

Once the processing is finished, the workflow is moved to the Completed section.

Click View Files to open a panel at the bottom, which lists the generated output files.

Click Open Folder to open the folder where the generated output files are saved.

Click View beside the output file to display it in the Viewport. Doing this also loads that 

particular output file in the Visualize tab so you can edit it further.

Click Close to exit from the panel.
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4.3.2.3 Failed

Any workflow that is processed unsuccessfully is displayed in the Failed section. A general error 

description is also provided.

4.3.3 Processing Settings

Select a workflow then click Processing Settings to access advanced customization settings. In addition 

to the General and Output tabs, an additional tab specific to the selected workflow may be available.

If the Aura application closes unexpectedly or the scan you are processing in Aura 

won't complete, it's important to Recover Aura log files, generate a DirectX 

Diagnostic file, and report the incident through the Customer Support form

online.

https://knowledge.emesent.com/recover-aura-log-files
https://emesent.com/customer-support/#incident
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4.3.3.1 General Tab
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Table 4 Processing Settings - General Tab

Field Data

Advanced feature 

matching

Enabling this stage of SLAM processing can improve results in most 

environments, but disabling it may provide better results in complex or 

repeating environments.

Exclusion Zones You can use this setting to exclude points close to Hovermap that may 

interfere with the SLAM algorithm or add noise to the point cloud (for 

example, those created by Hovermap itself, a drone, vehicle, or operator). We 

recommend that you use the default setting.

Mode:

Bounding Box: This option allows you to configure the minimum and 

maximum distance on each axis.

X Min / Forward: Points within this minimum distance at the front

of Hovermap are not processed.

Default setting: 1.5 m

X Max / Backwards: Points within this maximum distance at the 

back of Hovermap are not processed.

Default setting: 1.5 m

Y Min / Left: Points within this minimum distance to the left of 

Hovermap are not processed.

Default setting: 1.5 m

Y Max / Right: Points within this maximum distance to the right of 

Hovermap are not processed.

Default setting: 1.5 m

Z Min / Down: Points within this minimum distance underneath

Hovermap are not processed.

Default setting: 1.5 m

Z Max / UP: Points within this maximum distance on top of 

Hovermap are not processed.

Default setting: 1.5 m
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Field Data

Trim Data Use this setting to specify the time (in seconds) to ignore data from either end 

of your dataset. This can be useful, for example, if your scan gets off to a 

difficult start.

Start Delay: The number of seconds to be dismissed from the 

beginning of the scan.

End Cutoff: The number of seconds to be dismissed from the end of 

the scan (working backward).

Georeferencing Georeferencing Mode: Select the method used to obtain location data 

for accurately referencing the point cloud in real-world coordinates.

Drone RTK / Vehicle RTK / Backpack RTK: Select the device used 

to capture the scan data.

GPS: Use standard GPS data without real-time correction through 

RTK. This could still provide reasonably accurate georeferencing 

but might not achieve the same level of precision as RTK.
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Field Data

OGC WKT Standard: Select the Well-Known Text (WKT) format, which is 

used to represent coordinate reference systems and transformations. 

WKT provides a standardized way to describe spatial reference systems 

in a textual format.

WKT1: The original version of the Well-Known Text format. It 

describes coordinate reference systems and coordinate 

transformations in a textual representation and is widely used in 

various geospatial applications.

WKT2.2018: An updated version of the Well-Known Text standard 

released in 2018. This version includes improvements, additional 

functionalities, and other updates.

GNSS receiver type: The GNSS receiver used to capture the RTK data.

Base coordinate 

reference system

Select the CRS in which the data was originally collected. This information is 

essential for accurate transformations and reprojections to the target CRS.

Reprojection Toggle on to reproject the point cloud being processed.

Horizontal: Reproject to a different map projection or coordinate 

system.

Vertical: Convert from ellipsoidal height to orthometric height using a 

GEOID model.

For optimal results, ensure that the Georeferencing 

mode and GNSS receiver type match the hardware 

used during data collection. While the resulting point 

cloud remains usable, the accuracy may be 

compromised.
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Field Data

Point Filtering You can integrate automated filtering into the processing workflow by 

enabling any of the following noise filters. This may eliminate the need for a 

separate filtering step after processing. Note that only default settings are 

used, there are no options to adjust the filtering parameters.

Refer to the Main Toolbar section for more information on each filter and its 

associated parameters.

STX Noise Filtering: Filters out stray points by analyzing the range, 

intensity, and number of LiDAR points returned. Keep in mind that this 

process only applies to data collected from a Hovermap ST-X and will 

not have any effect on point cloud data gathered from other 

Hovermaps.

Adaptive SOR: Removes points that seem fuzzier than nearby points 

such as noise thickness from walls and floors.

Nearest neighbor: The number of point neighbors used for 

evaluation. A lower setting will result in quicker processing times 

but removes less sparse noise.

Alpha: Threshold for noise filtering. A lower setting will result in 

more aggressive filtering.

Denoise SOR: : Removes outlier point which are less likely to be real 

such as reflections.

Nearest neighbor: The number of point neighbors used for 

evaluation. A lower setting will result in quicker processing times 

but removes less sparse noise.

Log scale: Threshold for noise filtering. A lower setting will result in 

more aggressive filtering.

Moving object filtering: Removes moving points over 5 second 

intervals and keeps fixed point in the environment.

Motion level: Detects movement over 5 second intervals. The 

higher the value, the lesser moving points are selected.

Distance: The maximum distance for recovering fixed points. The 

higher the value, the more points are selected. A value of 1 to 2 cm 

are recommended for most scans.
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Field Data

Intensity: Set the minimum and maximum intensity values of points to 

be written to the output point cloud.

Range: Set the minimum and maximum range values of points to be 

written to the output point cloud.

Reset to Default Reset all settings to the default.

Advanced

The advanced settings contain additional processing parameters that can be adjusted to improve the 

output of the SLAM algorithm in certain circumstances. You should only use these settings when you 

are unable to achieve a quality output using the standard processing profiles.

We recommend that you only use these settings after talking to Customer Support.

Local mapping

Time Window

(Auto SLAM)

Time Window Sliding Size in Seconds: The length of the sliding 

window when running the optimization part of the SLAM process. 

Increase this value to improve the chance of a good output when there 

are a low number of geometric features in the scan. Increasing this 

number comes at the cost of increasing the processing time.

Default setting: 5 seconds

Time Window Sliding Shift in Seconds: Indicates how far the above 

window is shifted in each optimization loop. Decrease this value to 

improve the chance of a good output when there are a low number of 

geometric features in the scan. Decreasing this number comes at the 

cost of increasing the processing time.

Default setting: 1 second

Auto SLAM dynamically adjusts the Time Window processing 

parameters in real time when encountering challenging environments, 

such as tunnels, culverts, or expansive open areas with minimal 

geometric features. The parameter values configured in the user 

interface serve as optimal-case constraints; Auto SLAM will only exceed 

these thresholds when required to maintain tracking performance. This 

feature eliminates the need for manual intervention in most cases, such 

as switching to the "Low Feature" profile or modifying time window 

settings.

https://emesent.com/customer-support/
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Field Data

Point Filtering Intensity: Set the minimum and maximum intensity values of points to 

be written to the output point cloud. The defaults have been chosen to 

ensure that noise points from the sun are excluded. We recommend 

that you use the default settings.

Min default setting: 0

Max default setting: 255

Range: Set the minimum and maximum range values of points to be 

written to the output point cloud. The default values include all points 

out to the maximum range of the LiDAR.

Min default setting: 0

Max default setting: 300

Iterations Local Iterations: The maximum number of iterations that the main 

optimization loop performs during local mapping. Use this when you 

want to reduce local slips. Increasing this number will cause processing 

to take longer.

Default setting: 5

Local Iterations Internal: The maximum number of iterations that the 

internal optimization loop performs during local mapping. Use this 

when you want to reduce local slips. Increasing this number will cause 

processing to take longer.

Default setting: 5
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Field Data

Voxels Voxels Size: The lowest size of voxel used to generate surfels in SLAM. 

Use this inside smooth tunnels/bores, as most of the information within 

the points will be in the subtle variations in the surface direction that 

occur in relatively small dimensions. Increasing this number can 

significantly increase processing time.

Default setting: 0.4 m

Voxel Levels: The number of levels used to generate surfels in SLAM. 

Each level is twice the size of the previous level. Use this inside tunnels/

bores, as most of the information within the points will be in subtle 

variations in the surface direction that occur in relatively small 

dimensions.

Default setting: 5

Voxel Minimum Points: The minimum number of points in a voxel to 

use for SLAM. Use this to reduce the impact of noisy data on SLAM, or 

to ensure that features with a low number of points are included in 

environments with few geometric features.

Default setting: 8
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Field Data

Global registration

Point Filtering Intensity: Set the minimum and maximum intensity values of points to 

be written to the output point cloud. The defaults have been chosen to 

ensure that noise points from the sun are excluded. To include all 

points, use the default settings.

Min default setting: 0

Max default setting: 255

Range: Set the minimum and maximum range values of points to be 

written to the output point cloud. The default values include all points 

out to the maximum range of the LiDAR.

Min default setting: 0

Max default setting: 300

Iterations Global Iterations: The number of loops performed as part of the 

global registration process. Use this to reduce global slips. Increasing 

this number increases the likelihood of a quality output, but it will 

significantly increase processing time. 

Default setting: 10

Global Iterations Internal: The minimum number of iterations 

required to complete SLAM.
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Field Data

Voxels Voxel Size: The lowest size of voxel used to generate surfels in SLAM. 

Use this inside smooth tunnels/bores, as most of the information within 

the points will be in the subtle variations in the surface direction that 

occur in relatively small dimensions. Increasing this number can 

significantly increase processing time.

Default setting: 0.4 m

Voxel Levels: The number of levels used to generate surfels in SLAM. 

Each level is twice the size of the previous level. Use this inside tunnels/

bores, as most of the information within the points will be in subtle 

variations in the surface direction that occur in relatively small 

dimensions.

Default setting: 5

Voxel Minimum Points: The minimum number of points in a voxel to 

use for SLAM. Use this to reduce the impact of noisy data on SLAM, or 

to ensure that features with a low number of points are included in 

environments with few geometric features.

Default setting: 100

Velocity Local Linear Velocity Confidence: Allows you to decide how much 

confidence the global registration stage should place in the linear 

velocity results of the local mapping stage. The number is measured in 

standard deviation/error, so the higher the number, the lower the 

confidence. 

This is useful, for example, for long driving scans (over 

500 m), where the start and end of the scan should overlap, but do not 

do so cleanly, or where there are sharp changes in the trajectory that 

are inconsistent with the actual scan.

Significantly decreasing these values can help to keep the trajectory 

from being snapped to the correct global slips.

Default setting: 0.5
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Field Data

Local Angular Velocity Confidence: Allows you to decide how much 

confidence the global registration stage should place in the angular 

velocity results of the local mapping stage. The number is measured in 

standard deviation/error, so the higher the number, the lower the 

confidence.

Default setting: 0.8

Matching Number of Matches: Set the number of voxel matches that the SLAM 

algorithm will search for within the given restrictions. Increase this 

value to make the global registration more aggressive in searching for 

matching voxels and then adjusting the trajectory to make similar areas 

overlap.

This is useful for long driving scans, where increasing the number of 

global iterations fails to get the start and end of the scan to align. 

Increasing these values usually requires decreasing the Local linear 

Velocity Confidence and the Local Angular Velocity Confidence

values.

Default setting: 5

Max Distance: The maximum distance (in voxel units) that the SLAM 

algorithm will search for voxel matches. Increase this value to make the 

global registration more aggressive in searching for matching voxels 

and then adjusting the trajectory to make similar areas overlap.

Default setting: 10
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4.3.3.2 GCP Tab

Table 5 Processing Settings - GCP Tab

Field Data

Wait for GCP Target 

Manual Review

Select this checkbox to pause the software while the targets are confirmed.

Point Filtering Intensity: The filter intensities should be between 150 and 255, assuming no 

change to the target material.

If unselected, Emesent Aura will assume that the 

constellation of detected targets has been successfully 

matched to the survey points provided.
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Field Data

Detection These parameters help to identify a target.

Number of Points: The minimum number of points required before a 

cluster (in the global and local stage) can be considered a target.

Target Thickness: The maximum thickness of the cluster of points 

representing the target.

Target Standard Deviation: Specifies target thickness. It helps to 

detect and identify targets more accurately. As this number increases, 

GCPs will be more easily detected.

Default setting: 0.003 m (3 mm)

Reset to Default Reset all settings to the default.

4.3.3.3 Merge Tab
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Table 6 Processing Settings - Merge Tab

Field Data

Voxels Voxels Size: The lowest size of voxel used to generate surfels in SLAM. 

Use this inside smooth tunnels/bores, as most of the information within 

the points will be in the subtle variations in the surface direction that 

occur in relatively small dimensions. Increasing this number can 

significantly increase processing time.

Default setting: 0.4 m

Voxel Levels: The number of levels used to generate surfels in SLAM. Each 

level is twice the size of the previous level. Use this inside tunnels/bores, 

as most of the information within the points will be in subtle variations in 

the surface direction that occur in relatively small dimensions.

Default setting: 5

Voxel Minimum Points: The minimum number of points in a voxel to use 

for SLAM. Use this to reduce the impact of noisy data on SLAM, or to 

ensure that features with a low number of points are included in 

environments with few geometric features.

Default setting: 8

Matching Number of Matches: Number of surfels to look for matches during SLAM.

Max Distance: Maximum distance (in voxels) to search for surfel matches.



Emesent Aura User Manual

Release date: 22 Apr 2025
Revision: 3.4

37

•

Field Data

Georeferencing Georeferencing Mode: Select the method used to obtain location data for 

accurately referencing the point cloud in real-world coordinates.

Drone RTK / Vehicle RTK: A satellite navigation technique used to 

enhance the precision of position data obtained from GPS (Global 

Positioning System). It relies on a fixed base station and a mobile 

receiver. The base station precisely knows its location and 

communicates correction signals to the mobile receiver. Select this 

mode to allow the point cloud data to be aligned and referenced 

using highly accurate, real-time corrected GPS signals obtained 

through RTK technology.

GPS: A satellite-based navigation system that provides location and 

time information anywhere on Earth. Choosing GPS as the 

Georeferencing Mode might mean that the software will use standard 

GPS data without real-time correction through RTK. This could still 

provide reasonably accurate georeferencing but might not achieve 

the same level of precision as RTK.

OGC WKT Standard: Select the Well-Known Text (WKT) format, which 

is used to represent coordinate reference systems and 

transformations. WKT provides a standardized way to describe spatial 

reference systems in a textual format. WKT1 is recommended for best 

compatibility.

WKT1: The original version of the Well-Known Text format. It 

describes coordinate reference systems and coordinate 

transformations in a textual representation and is widely used in 

various geospatial applications.

WKT2.2018: An updated version of the Well-Known Text standard 

released in 2018. This version includes improvements, additional 

functionalities, and other updates.
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Field Data

Reset to Default Reset all settings to the default.

•

•

For PLY and trajectory files in UTM or WGS84 

coordinates, an additional PRJ file containing the 

projection information in OGC WKT format is written. 

LAS files contain the projection information in the file 

header.

If there is no GPS data recorded by Hovermap in the 

dataset, the output will only be in local coordinates, 

with the origin at the start of the scan.
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4.3.3.4 Colorize Tab
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Table 7 Processing Settings - Colorize Tab

Field Data

Video Time Range Sets the start and end time when frames are extracted from the video.

Frame extract 

interval

Uses the maximum time, distance, and angle to determine the number of video 

frames to skip between image extractions, keeping only the necessary images.

Time: We recommended this setting is turned off to avoid repetitive 

extractions when the camera is not moving. The recommended range is 

between 1 to 20.

Distance: Extracts images based on the distance the camera travels to 

avoid repetitive images when standing still. The recommended settings 

are 1 to 2 for small, confined spaces and 5 to 10 for moving capture in 

open spaces.

Angle: Extracts images based on changes to the camera angle. The 

recommended settings are 10 to 15 degrees when using a perspective 

camera and 45 to 90 degrees when using a 360 camera.

The time represents the elapsed video time, not the 

number of seconds to trim from the end of the total video 

duration. Setting the Video end time to 0 will include 

everything after the start time.
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Field Data

Processing Quality Point Color Radius: Adjusts the occlusion size of the points for 

colorization. A smaller value may cause color of foreground objects to 

bleed onto background points, larger values may result in background 

points that are near foreground points not to get colored. The 

recommended range is between 0.01 and 0.03.

Visibility Voxel Size: Determines the resolution of 3D pixels

(in meters). A lower setting results in finer colorization quality

and increased processing time. The recommended range is

between 0.01 and 0.1.

Colorization Distance: Adjusts the maximum distance of

points from the GoPro camera to be colorized. A higher setting

results in more points being colorized and increased

processing time. The recommended range is between 10 and

300.
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Field Data

Reduce blue sky 

bleeding

Allows you to reduce and mask out the color bleed or the blending of blue or 

gray sky on buildings and other objects.

Strength: Adjust the intensity of the filter to mask the blue or gray sky. 

Use the Low setting for clear blue skies. For gray overcast conditions or 

scenes with complex features like trees, varying colors, or cloud patterns, 

a Medium to High setting is recommended. Note that higher strength 

settings may increase the likelihood of masking light-colored buildings.

Alternatively, toggle on the Advanced option and configure the following:

RGB blue: Set the minimum value of the blue channel to detect blue sky. 

A value of 200 is recommended for most sky types, 120 for blue skies 

with light-colored buildings, and 150 for low-light conditions such as 

dawn and dusk.

Gray intensity: Used to detect gray sky. A value of 0 is ideal for blue 

skies, 20 for overcast (gray skies), and 50 for darker gray clouds. Higher 

values may result in unintentional masking of gray or light-colored 

buildings.

Color detection: Identifies and masks colors with the specified RGB 

values. Use a setting of 25 for detecting gray skies, 35 for blue or light 

blue skies, 50 for blue skies with trees, and 75 for gray clouds with trees. 

Note that higher values may lead to unintentional masking of gray or 

light-colored buildings.

When reviewing the frames between extraction and 

colorization, you should see the sky effectively masked in 

most frames. Some frames might still show minor visible 

patches of sky or unintended masking of building parts, 

but this should not impact the final colorized point cloud 

significantly if these issues occur only occasionally. In 

cases like these, it is generally better to increase the filter 

strength rather than decrease it, as remaining bits of 

visible sky are more likely to be noticeable in the final 

point cloud than a few mistakenly masked building parts, 

especially if the building is clearly visible in other frames.
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Image Masking This allows you to hide unwanted features from all your extracted frames. 

Choose from the available mask templates depending on the accessory/

platform you are using. To create your own, Refer to the Creating a Custom 

Mask section for instructions.

Output Remove Uncolored Points: This allows you to include or exclude points 

from the original scan that could not be colorized.

Default setting: Unselected

Keep Frame Images: This allows you to keep or remove the GoPro 

image frames from the colorization output folder. Select this option to 

use image frames and pose data in third-party software. De-select this 

option to save hard drive space.

Default setting: Selected

Reset to Default Reset all settings to the default.

4.3.3.5 Extract 360 Images Tab
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Table 8 Processing Settings - Extract 360 Images

Field Data

Video Time Range Sets the start and end time when frames are extracted from the video.

Frame extract 

interval

Uses the maximum time, distance, and angle to determine the number of video 

frames to skip between image extractions, keeping only the necessary images.

Time: It is recommended to turn this setting off to avoid repetitive extractions 

when the camera is not moving. The recommended range is between 1 to 20.

Distance: Extracts images based on the distance the camera travels to avoid 

repetitive images when standing still. The recommended settings are 1 to 2 for 

small, confined spaces and 5 to 10 for moving capture in open spaces.

Angle: Extracts images based on changes to the camera angle. The 

recommended settings are 10 to 15 degrees when using a perspective camera 

and 45 to 90 degrees when using a 360 camera.

Camera orientation 

override

Allows you to configure the camera’s orientation settings manually.

Roll: Configure the rotation around the front-to-back axis.

Pitch: Configure the rotation around the side-to-side axis.

Yaw: Configure the rotation around the side axis.

Image Masking This allows you to hide unwanted features from all your extracted frames. 

Choose from the available mask templates depending on the accessory/

platform you are using. To create your own, Refer to the Creating a Custom 

Mask section for instructions.

The time represents the actual elapsed video time, not the 

number of seconds to trim from the end of the total video 

duration. Setting the Video end time to 0 will include 

everything after the start time.
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4.3.3.6 Output Tab

Table 9 Processing Settings - Output Tab

Field Data

Point Cloud - 

output file types
PointCloud LAZ (1.4): Output a point cloud in compressed LAS 1.4 format

Default: On

PointCloud LAS (1.4): Output a point cloud in uncompressed LAS 1.4 

format.

Default: Off

E57: Output a point cloud in an E57 format.

Default: Off

PointCloud LAZ (1.2): Output a point cloud in compressed LAS 1.2 format.

Default: Off

PointCloud LAS (1.2): Output a point cloud in uncompressed LAS 1.2 

format.

Default: Off

PLY: Output a point cloud in PLY format.

You can select more than one option.
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Field Data

Subsampling Subsample Point Clouds: Generate a subsampled point cloud for each of 

the selected options above.

Default: On

Subsample Factor: The fraction of the points in the point cloud to sample. 

For example, 0.10 will output 10% of the points. Default: 0.10

Reset to Default  Reset all settings to the default.
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4.4 Main Toolbar

The Main Toolbar contains several tools for navigating and interacting with your point cloud. It can be 

docked to the top or bottom of the viewport (or it can be a floating panel). These tools are grouped 

based on usage. The icon displayed in the toolbar indicates the tool that has been selected for that 

group.

1.

2.

3.

4.

5.

6.

7.

8.

9.

Navigate

Translate

Rotate

Axis Lock tools

Selection tools

Cleaning filters

3D View menu

Measurement tools

Undo / Redo

The Undo/Redo function is only currently available for certain tools. If you need to 

make any major changes, we recommend that you first save your file using the 

Save or Save as options in the Project Menu.
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Table 10 Main Toolbar

Button Action

Navigate

Navigate: Move around the point cloud, as opposed to shifting it. 

Left-click your mouse to choose the center of rotation. This point 

will be shown by a white ball.

Double-click your mouse to lock the rotation on an exact point. The 

ball will turn orange. Double-click again to unlock.

Translate

Translate: Move your point cloud along different axes. Click on the 

arrow to choose which axis. Select the square to translate along 

multiple axes.

Rotate

Rotate: Click on the desired axis to rotate your point cloud around 

that axis.

Axis Lock

Rotates your point cloud around the selected axis.

Right-click and drag to translate along the locked axis.

Double-click your mouse to lock the axis on an exact point. The ball will turn orange. You can change 

the axis while the ball is orange, and the new axis will rotate around the same point.

Double-click again to release.

X Axis Lock: Locks the point cloud rotation to the X axis, which is 

represented by a red line.

Y Axis Lock: Locks the point cloud rotation to the Y axis, which is 

represented by a green line.
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Button Action

Z Axis Lock: Locks the point cloud rotation to the Z axis, which is 

represented by a blue line.

Selection tools

Select Points: Select and deselect points within the square 

selection box. This function is good for point cloud cleaning, as well 

as for selecting targets in the GCP workflow.

Right-click your mouse, or press the Esc key to remove the 

selection.

Select Area: Select a 2D region (often represented as a polygon) in 

the point cloud to encompass multiple points within that defined 

area.

Right-click your mouse, or press the Esc key, to remove the 

selection.

Select Volume: Define a 3D region or volume in the point cloud 

and select all points falling within that defined volume.

When this tool is selected, the color of the point cloud changes to 

grayscale and a 3D bounding box becomes available. Drag the 

arrows in the bounding box to select all points within that volume.

This selection tool is useful for tasks such as object extraction or 

isolating specific structures in the point cloud.

Not available when working with meshes.

Not available when working with meshes.
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Button Action

Delete selection: Deletes any points you have selected.

Cleaning Filters

Decimate by distance filter: Subsamples the point cloud by 

specifying the minimum distance allowed between points 

(measured in meters). You can either select or delete the points.

This tool is useful when you want to thin out your point cloud to 

make it easier to navigate. The smaller the point cloud, the more 

responsive it will be. You may have to experiment with the settings 

to achieve the desired result.

There are three input parameters:

Minimum distance: Select the minimum distance between 

points.

Default setting: 0.01 (1 cm)

Point decimated: Specify whether the points should be 

deleted or selected.

Default setting: Delete

Invert: Inverts the selection calculated by the DBD algorithm.

•

•

Not available when working with 

meshes.

Be careful, as there is no undo function 

available for this action. Be sure that 

you want these points deleted before 

you do so.

Not available when working with meshes.
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Button Action

Classic SOR: Removes stray points in a dense point cloud. This filter 

works out the average distance of each point from its neighboring 

points. It then rejects the points that are farther than the average 

distance. All points outside of this distance are considered outliers 

and can be removed from the dataset. You may have to experiment 

with the settings to achieve the desired result.

Denoise SOR: Removes noise in a dense point cloud. This filter 

analyzes the point cloud to identify points that are likely to be noise 

or outliers. Points that significantly deviate from the expected 

parameters are considered outliers and are removed from the 

dataset.

Adaptive SOR: Adaptively removes outliers while considering 

variations in point density and noise levels across different regions 

of the point cloud dataset. This filter can be particularly useful in 

cases where the point cloud has varying levels of detail.

The available parameters vary depending on the SOR type.

Nearest neighbor: The number of neighboring points 

required to calculate the average distance for a given point.

Default setting: 6

Alpha: If Adaptive SOR is selected, this setting controls the 

adaptability of the filter to local point density variations. A 

higher value leads to more adaptive thresholding and can be 

useful for handling data with varying point density. A lower 

value might make the filter less sensitive to density changes 

and provide a more uniform filtering behavior.

Log Scale: If Denoise SOR is selected, this setting emphasizes 

details in regions with lower point density and reduce the 

impact of regions with high point density. It allows the filter 

to treat points with different magnitudes more uniformly, 

enhancing the denoising process by effectively dealing with 

variations in the dataset.
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Button Action

nSigma: If Classic SOR is selected, this option will calculate 

the mean distance from every point to its neighboring points. 

The result is a normal distribution. You can use decimal 

values here. The lower the number you choose, the more 

points will be trimmed from your dataset.

Default setting: 1

Point outlying: Choose whether the outlying points will be 

deleted or just selected.

Invert: Select or delete everything in the point cloud except

for the statistical outlying points.

Moving object filter: Removes points over 5 second intervals and 

keeps fixed points in the environment. 

Identifying moving objects within a point cloud is done by 

estimating statistical scores for points based on their temporal and 

spatial relationship to their neighborhood. These scores provide a 

quantitative measure of the likelihood that a point belongs to a 

moving object, enabling the Moving Object filter to differentiate 

between dynamic and static elements in the point cloud.

Refer to the Moving Object Filtering section for more information.

3D view menu

Focus: Fits the point cloud to your screen.

Front: Shows the front view of the point cloud.

Top: Shows the top view of the point cloud.

Right: Shows the view from the right of the point cloud.

Left: Shows the view from the left of the point cloud.

Not available when working with meshes.
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Button Action

Back: Shows the back view of the point cloud.

Bottom: Shows the view from the bottom of the point cloud.

Measurement tools

Point measurement: Click anywhere in your point cloud to show 

coordinates for a single point. Click again to clear your selection.

Line measurement: Select any two points to show the distance 

between them and the coordinates for each point. Click a third 

point to reset the tool and take another measurement.

Angle measurement: Select three points to measure the angle 

between them. Shows coordinates for each point.
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Button Action

Undo / Redo

The undo/redo actions are currently limited to the following 

actions:

Translate

Rotate

Point size, point bias, point shape

Color scale selector

Colorization filter

Fill color

Scalar gradient, with associated Scalar Filter upper/lower 

limit and scalar range changes

The undo and redo functions are not currently 

available for delete actions, DBD and SOR 

filters, so be careful when performing these 

actions. Further functionality will be explored 

in future releases.
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4.5 Context Panel

The Context Panel enables you to make further modifications to your processed point cloud or GCP 

data. The available settings vary depending on the selected file in the Visualize tab. The Context panel 

can be docked to the left or right of the screen or made as a floating panel. Refer to the docking 

instructions found in the Visualize Tab section for more information.

4.5.1 Point Clouds

There are two panels available when you select a point cloud. These panels can either be docked 

together or displayed separately.

4.5.1.1 Point Cloud Visualization

These settings help customize the point cloud’s appearance to suit specific analysis requirements or 
highlight crucial details for better understanding and interpretation of the dataset.

There is no associated Context panel for meshes.
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Table 11 Context Panel - Point Clouds

Field Data

Shape Square: Each point is shown as a square.

Circle: Each point is shown as a circle.

Colorization If toggled on, no Color Scale or Scalar Gradient is available, as colorization 

overrides these options.

If you can’t toggle on colorization, this means that you have a file that hasn’t 
been colorized.

Color Scale The color scale specifies filtering settings for the following scalar fields:

Solid: A solid color, with no gradient. Choose this option for better 

contrast between selected points and the rest of the point cloud. This 

option can also provide more contrast against the background.

Elevation: Shows the elevation of each point in the point cloud. The 

color scale goes from blue (low elevation) to red (high elevation).

Position: Colors your point cloud on all three axes (X, Y, and Z). The X 

axis is blue, the Y axis is red, and the Z axis is green.

Classification: Colors your point cloud based on classifications, 

objects that have been identified (such as pipes) will be shown in 

randomized color selections. Currently, classification can not be 

generated by Aura.

Intensity: Shows the intensity of each point in the point cloud. This is 

particularly useful for detecting targets in your point cloud.

Time: Shows the time that each point was collected during the scan.

Ring: Shows primary colors, one for each of the Hovermap lasers. This 

option can be used for calibration, to check that all lasers are present 

in the scan data.
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Field Data

Range: Shows the distance of each point from Hovermap.

Return: Shows the laser strength and return order. This can be used 

for troubleshooting and point cloud cleaning.

Point Size Controls the size of each point. If the point size is set to 0, the points will 

appear as pixels (instead of the shape chosen in the Shape field).

Default setting: 1

Scalar Gradient This option gives you a range of color ramps to choose from. It is available on 

all attributes except when Classification, Position, or Solid color scale is 

selected.

Scalar Filter The option is available when the Intensity, Time, Elevation, Return, or 

Range color scale is selected.

A histogram chart allows you to visualize the intensity, time, or range 

distribution of your data. You can move the stops at each end of the graph to 

control how the color is presented, and specify histogram min. and max. 

values with an input value.

Scalar Range The Scalar Range is the slider that sits below the graph. You can adjust the 

upper and lower stops to show a specific range of data.

For example, if you only want to see points with an intensity between 100 

and 200, you can adjust the stops to show only that range of data.

Emesent Aura can detect the contents of the point 

cloud file and apply the appropriate color scale filter. 

Only the appropriate filters will appear in the dropdown 

list. For example, the Ring option will only be available 

for Emesent scans, as it detects information from 

Hovermap. If you have imported a third-party scan, the 

Ring option will not be available.



Emesent Aura User Manual

Release date: 22 Apr 2025
Revision: 3.4

58

4.5.1.2 Point cloud properties

If the selected point cloud is georeferenced, this panel displays the number of points and other 

important information such as transformations, scaling, and offsets applied to ensure accurate spatial 

representation.

Table 12 Context Panel - Point Clouds

Information Description

Points The number of points in the point cloud dataset (total number of points if 

multiple point clouds are selected).

Projection Information Provides details about how the point cloud data is represented spatially.

Coordinates The geographic coordinates indicating its global position.

Transformations Shows the scaling factor and the offsets applied to coordinates.
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Information Description

Origin offset The translation or displacement applied to the point cloud data's origin.

Bounding box The dimensions of the bounding box around the point cloud data in each 

direction (X, Y, Z axis).

4.5.2 Ground Control Points

The Context panel for GCPs contains tools to help you georeference your point cloud.

4.5.2.1 Edit Constellation

A constellation is a set of coordinates that represent the real-world locations of the targets that were 

used during scanning. Emesent Aura attempts to automatically match targets of the appropriate size 

and intensity to locations within this constellation. This list allows you to choose which potential target 

identified in the point cloud is associated with which landmark in your constellation.

A landmark can have multiple GCP targets associated with it to provide 

redundancy and improve accuracy.
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1.

2.

3.

4.

5.

6.

7.

8.

Setting Description

Show/Hide 

Landmark

Toggles between showing or hiding the selected landmark from the 

Viewport.

Show/Hide Target Toggles between showing or hiding the selected target from the Viewport.

Expand/Collapse Toggles between showing just the landmark or the landmark and its 

associated targets. This is useful if you have a long list of coordinates.

Focus Zooms in on the selected target on the Viewport.

Remove Target Removes the selected target from the constellation and moves it to the 

Inactive Targets list. This can be useful in situations where the target was 

incorrectly identified during the initial georeferencing process.

Refer to the GCP Workflow section for more information on matching 

targets to the correct landmark.

Deactivate 

Landmark

Removes the selected landmark and its associated target(s) from the 

constellation. It is important to exercise caution when using this function 

to ensure that you are removing the correct landmark and that it will not 

adversely affect the overall accuracy and alignment of the point cloud. 

When prompted, click Deactivate to confirm the removal.

Save Constellation Saves the changes you made to the constellation file.

Quick Save This option is only available when running the GCP processing workflow. If 

you use the Quick Save option, the saved file will overwrite the 

constellation.yaml file that was originally produced during processing. 

This is important, as Emesent Aura will look for this file to run the next 

steps in the process.

If you open an existing GCP project, the Quick Save 

option will not be available.
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3.

4.5.2.2 Inactive Landmarks

This list contains identified landmarks that have not yet been matched to any target in the 

constellation. When aligning point cloud data to a known coordinate system using GCPs, Aura will 

detect landmarks within the point cloud but they may not be suitable as GCP targets. You can choose to 

delete these landmarks before GCP data processing. If not, these will be listed as inactive landmarks in 

the Context panel so you can add them to the constellation if required.

Setting Description

Show/Hide Inactive 

Landmark

Toggles between showing or hiding the selected landmark from the 

Viewport.

Focus Toggles between showing or hiding the selected inactive landmark from 

the Viewport.

Add to 

Constellation

Moves the selected inactive landmark to the Edit Constellation list. You can 

then assign a target to the newly added landmark by dragging the target 

to the field below it.
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4.5.2.3 Inactive Targets

This list contains identified targets that have not yet been matched to any landmark in the 

constellation. Any targets left in the Inactive targets list will be disregarded when reprocessing the 

point cloud.

Setting Description

Show/Hide Inactive 

Targets

Toggles between showing or hiding the selected inactive target from the 

Viewport.

Add Target Creates a new target. Select an area of points and click the Add Target

button to create a new target.

Trash Target Deletes the selected inactive target. It is important to exercise caution 

when deleting a target as you will not be able to recover it once deleted. 

When prompted, click Delete to confirm deletion.
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4.6 Viewport

Use the Viewport to navigate and manipulate your point cloud. The Viewport also shows live X/Y/Z 

mouse coordinates. Press the F1 key in Aura at any time to access Help and see the full range of mouse 

actions and keyboard shortcuts available to you.

The bounding box shows the extent of your point cloud. You cannot interact with 

the bounding box but you can hide it by unselecting the the point cloud on the 

from the Visualize tab.
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5. Working with Point Clouds

5.1 Processing Profiles

A profile is a group of processing settings that allow you to optimize processing for specific 

environments and situations. Emesent Aura has several built-in profiles available for processing, 

georeferencing, merging, and colorization. These built-in profiles will give good results in most 

situations.

If the built-in profiles don’t cater to your needs, Emesent Aura also allows you to create and save 
custom profiles.

5.1.1 Built-in Profiles

The following built-in profiles are available.
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Workflow Profiles

Process Standard: We recommend that you use this profile for most processing 

operations. Sometimes this profile won’t give you an outcome that you are 
happy with. If your point cloud output includes ghosting, copies of objects, or 

overlapping objects, or if the trajectory file significantly diverges from known 

information about the actual trajectory (for example, where a dataset from a 

closed loop scan is processed and the trajectory file shows the start and end 

points are a significant distance apart), we recommend that you try one of the 

other three built-in profiles.

The default georeferencing mode for this profile is set to None.

Low Features: Use this profile for environments with relatively few geometric 

features. It includes adjustments to window size and iterations. This profile can 

improve point clouds from some environments, but it can also result in worse 

point clouds from others.

More Iterations: This profile is designed for environments that are more 

challenging for the SLAM algorithm to handle. It increases the number of 

iterations.

Forest: This profile is designed for environments that are largely or exclusively 

natural terrain and vegetation. It includes adjustments to the way that global 

registration is performed.

ST-X: This profile contains the recommended intensity and range filtering 

settings as the ST-X LiDAR has a greater range and is more sensitive than older 

hardware.

Disable Feature Matching: This profile is recommended when scanning 

featureless or repeating environments such as multi-story building car parks.

GCP Standard: The default profile for a GCP workflow. This profile will cater to the 

most common georeferencing jobs.

ST-X: This profile contains the recommended settings for detecting targets 

when georeferencing the point cloud.

Auto SLAM eliminates the need to switch to the "Low 

Features" profile in most scenarios.
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Workflow Profiles

Merge Standard: The default profile for a merge process. This profile will cater to the 

most common merge jobs.

Outdoor Indoor: This profile can give better results when merging datasets 

that have overlaps between outdoor and indoor environments.

Complex Building: This profile can give better results when merging datasets 

from complex building structures, such as buildings with multiple levels or with 

multiple similar rooms.

Terrain: This profile can produce better results when merging datasets from 

outdoor environments with large open areas.

Colorization Standard: This default profile provides a set of configuration parameters that 

should suit most colorization requirements. It achieves a good balance of 

output quality vs processing time for most datasets.

Quick: This profile delivers a faster output at the cost of quality. This option is 

useful when reviewing results in the field. Only one video frame every 5 

seconds is used to colorize the points, which may result in gaps or poor 

colorization.

Quality: This profile increases the quality of the colorized point cloud at the 

cost of increased processing time. It uses 10 frames every second (instead of 

two, which is standard), and decreases the visibility voxel scale from 250 mm 

to 100 mm.

Driving: This profile is useful when colorizing scans done at higher speeds (for 

example, driving scans). It uses 10 frames per second (instead of two, which is 

standard) to ensure sufficient coverage at high speed.

Extract 360 Images Telescopic mount extended: This profile provides orientation parameters for 

extracting images on a 360 camera captured with the telescopic mount fully 

extended.

Telescopic mount retracted: This profile provides orientation parameters for 

extracting images on a 360 camera captured with the telescopic mount 

retracted.

360-camera mount calibrated: This profile provides parameters for 

extracting images on a 360 camera captured with the calibrated 360-camera 

mount.
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3.
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5.

5.1.2 Custom Profiles

When you make changes to a built-in processing profile in Emesent Aura, a temporary custom profile is 

created. You can choose to save this custom profile to save time in setting up processing jobs for 

common or known environments. Once saved, it becomes available for selection in the Profiles

dropdown list.

To create a new processing profile:

Go to the Process tab then click Process Scan.

Select the workflow to create a new profile for then click the Add Profile icon.

In the Create Profile dialog box, enter a name for the new profile then click Create.

Click Processing Settings then customize the settings for the new profile.

Click Save. Your new profile should now be available in the dropdown list.

If you choose not to save the custom profile, it is automatically removed when the 

application is closed.
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6.

To save a custom profile:

Go to the Process tab then click Process Scan.

Select a workflow then select from one of the available built-in profiles.

Click Processing Settings then edit the settings of the built-in profile.

Click Save to go back to the main panel. The selected profile changes to the newly created 

“Custom” profile.

Click Save Profile.

In the Create Profile dialog box, enter a name for the new profile then click Create. Your new 

profile should now be available in the dropdown list.
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5.2 Output Folders

Point cloud processing (SLAM) involves a sequential series of stages, usually Odometry, Atlas, and 

Global.

These files are stored in the following folders:

Folder Description

IntermediateFiles Contains the intermediate results, which are not 

intended for direct user interaction. A subfolder is 

created for each processing stage (e.g., 

"offline_odom").

Output Contains the final output artefacts associated with the 

processing workflow.
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5.3 Process Workflow

To create a point cloud from your raw Hovermap data, you need to process the scan in Emesent Aura.

The basic process for generating a point cloud is as follows.

5.3.1 Step 1: Retrieve your scan data

Follow the Hovermap workflow to capture your scan data. Once you have completed your scan, insert a 

USB flash drive into Hovermap to download the data. The status LEDs will change to a light flashing 

blue while the scan is being transferred.

Once the transfer is complete, the status LEDs will return to a slow pulsing Emesent blue. You can now 

remove the USB flash drive.

5.3.2 Step 2: Copy the data to your computer

Copy the data from the USB flash drive to a local drive on your computer so that you can begin 

processing.

If you are planning to georeference your scan, you may skip this process as point 

cloud processing is also performed when using the GCP workflow. Refer to the 

GCP Workflow section for more information.

Because of Aura's significant processing requirements for generating a point 

cloud from Hovermap data, we recommend your laptop is connected to a power 

outlet during Step 5: Processing.

To retrieve data, the USB flash drive must be formatted in an exFAT file format.

https://4999118.hs-sites.com/en/knowledge/hovermap-start-up-and-led-color-guide
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5.3.3 Step 3: Configure your processing job

Open Emesent Aura. Make sure you have an active SLAM license.

In the Process tab, click Process Scan.

In the Configure New Scan Job panel, select the Process workflow.

Click Add Dataset.

Browse for the folder that contains the raw point cloud dataset to be processed. Select that 

folder.

In the Location field, enter the preferred name for the output folder. Emesent Aura will create 

this folder, which stores all the processed results and data, as a child directory within the raw 

scan folder.

Select the processing profile to use. Refer to the Processing Profiles section for more information 

about which profiles to use and how to create a custom profile.

Scans from a Hovermap that use Emesent Cortex version 3.3 (or later) can only be 

processed in Aura 1.7 (or later).

For scans from a Hovermap that use Emesent Cortex version 3.3 (or later), it is 

essential to ensure that both metadata.yaml  and 

platform_configuration.yaml  files are included in the same folder as your 

scan files. These files contain crucial information required for processing the point 

cloud data.
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5.3.4 Step 4: (Optional) Use RTK Data

If RTK data is detected in your dataset, toggle on Use RTK data to use the real-time corrections 

provided by the RTK system to improve the georeferencing accuracy of the point cloud data.

More information on processing and reprojecting a georeferenced scan is provided in Reprojecting 

your Point Cloud section.
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5.3.5 Step 5: Processing

Click Start to begin processing. The Configure New Scan Job panel is replaced with the Starting 

Processing Job panel and shows a progress bar showing how far along you are in your 

processing job. In addition to the progress bar, the elapsed time of the processing job is shown 

to the right. 

The directory file path below the progress bar provides a way to identify the dataset source. This 

is useful if simultaneously processing multiple jobs with the same output folder name. Copying 

the file path and pasting it on your computer’s file explorer allows you to access the completed 
files without having to wait for the processing job to be completed.

The processing job will proceed through the local and global processing phases and finally 

generate the output processing files. You can load and interact with other point clouds while 

processing in the background.

Refer to the Output Files section for more information on where the generated files are stored 

once the processing is completed.

The resulting point cloud is added to the child directory created within the raw scan folder.

The Retry button becomes available if a failure occurs during processing. Click 

this button to attempt to process the current job from the last successful stage.



Emesent Aura User Manual

Release date: 22 Apr 2025
Revision: 3.4

74

1.

2.

5.3.6 Step 6: View your point cloud

Once your processing job has finished, the bottom panel displays the generated files.

Click View beside each generated file to load them into the Viewport for analysis or further 

editing. The following main files are generated:

Full point cloud 

The point cloud with the complete set of data points. The output file type varies depending 

on the profile used in generating the point cloud. The filename includes the output folder 

name with the output file type appended to it. 

For example: Output_laz1_4.laz where the output file type is PointCloud LAZ (1.4) and the file 

is located in the “Output” folder.

Subsampled point cloud

The point cloud containing a subset of points from the original point cloud dataset (based on 

Subsample Factor value in Processing Settings). This output is only generated if 

Subsample Point Clouds is enabled in the Output tab of the Processing Settings panel.

Trajectory file 

The data file containing the recorded movement or path of the Hovermap as it acquired the 

point cloud data.
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1.

a.

b.

c.

2.

a.

b.

c.

5.4 Cleaning your Point Cloud

Every user will clean their point clouds slightly differently. We recommend the following process.

5.4.1 Step 1: Copy your point cloud file

Start by making a copy of your original point cloud file. This will be the file you work on in Emesent 

Aura.

5.4.2 Step 2: Open in Emesent Aura

Open the copy file in Emesent Aura. You can do this in one of three ways:

In the top-left menu, click the Project Menu icon then select Open in the menu that displays.

Drag and drop your file directly into the viewport.

Go to the Visualize tab then click Add next to your chosen section.

5.4.3 Step 3: Make your point cloud visible

To ensure you can easily see all points for cleaning purposes, we recommend doing the following.

Change the point cloud to a solid color:

Select the point cloud to display its Context panel.

In the Color Scale field, click Solid.

In the Fill Color section, choose a color for your point cloud that contrasts with sepia (which 

is the default selection color).

Note: When you change the color of the point cloud, the color of the bounding box 

automatically changes at the same time. This is useful if you have multiple point clouds 

open. It allows you to see the extent of each point cloud (assuming they are different colors).

Change the background color to a solid color:

In the top-left corner, click Preferences.

In the Preferences dialog box, go to the Appearance tab.

In the Background section, select Solid.
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3.

Choose a color that stands out against the point cloud color. We recommend that you avoid 

using a black background for clean-up, as it can make points easier to miss (especially if you 

are working with a colorized point cloud)

Click Save.

Change your point size so that the points are easily seen:

Go to the point cloud panel.

In the Point Size field, set the value to 1 or greater.

5.4.4 Step 4: Start with a small area

We recommend that you clean only small areas of your point cloud at a time (particularly if you are 

cleaning using filters). If you clean the whole point cloud at once, you may accidentally remove features 

that you did not intend to, and there is currently no undo function for deletion.

Select a small area of your point cloud. If this area is on the edges of your point cloud, make sure 

that it includes at least a portion of the main point cloud, not just the peripheral points. The 

reason for this is so that Aura has a better idea of the mean distance between all the points, not 

just the peripheral ones. If you only select the points on the edges, this could skew your filtering.

To find points that may have been selected further into the distance, you can either:

Navigate to the other side of your point cloud to check that nothing else has been selected.

Use the near clipping plane, which will allow you to see through areas of your point cloud. To 

do this, go to the Preferences menu and change the value in the Near Clipping Plane field. 

Experiment with what works best for you.

Refine your selection as follows:

To add points: Shift + select

To remove points: Ctrl + select

To invert your selection: Alt + select

When you choose an area, a selection will be created that extends back through 

the point cloud. This means that your selection includes points that are behind 

your visible selection, which may not be your intention. If you have opted for 

perspective mode in your global preferences, the selection's shape will expand as 

it moves further into the distance. On the other hand, if you have chosen 

orthographic mode, the shape will remain the same throughout the point cloud.
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5.4.5 Step 5: Use the SOR filter

We recommend using the SOR filter for your first clean before you do your manual point removal. This 

is a good way to clean up the edges of your scan, where there is usually quite a bit of noise.

The SOR filter allows you to remove stray points and noise in a dense point cloud. This filter works out 

the average distance of each point from its neighboring points. It then rejects the points that are 

farther than the average distance. All points outside this distance are considered outliers and can be 

removed from the dataset. You may have to experiment with the settings to achieve the desired result.

Once you have selected your area for cleaning, go to the Main Toolbar.

Click the Cleaning Filters icon then select SOR filter.

In the Statistical Outlier Removal dialog box, select the SOR filter to use. Refer to the Main 

Toolbar section for more information on the different SOR filters and their associated settings.

Once you have configured the settings for the selected SOR filter, click OK.

Automated filtering can be integrated into the processing workflow. To do this, go 

to Processing Settings. In the Point Filtering section of the General tab, enable 

the cleaning filter(s) to be automatically applied during processing.

The bounding box, which shows the furthest extent of the points in your point 

cloud, does not automatically adjust when trimming points. Save the point cloud 

first then reload it to see the adjusted bounding box.

If no selection is made, the filter is applied on the entire point cloud that is 

currently selected. The filter is disabled if multiple point clouds are selected in the 

Visualize tab.
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Points selected for clean-up will change to a sepia color. If you are happy with the selection, 

proceed to delete these points.

Run the SOR filter in the same area until you are happy with the result.

5.4.6 Step 6: Do a manual clean-up

Once you have finished using the filters for your initial clean-up, you can then do a manual clean-up. Go 

to the Main Toolbar section for more information about each tool.

5.4.7 Step 7: Save

From the Project Menu, click Save to save the changes to the existing file. Use Save As to create a copy 

of your point cloud with a different name, location, or file format.

The DBD filter is not suitable for point cloud clean-up. It is more suitable for 

meshing, as you’re effectively just subsampling the point cloud by running this 
filter. Currently, meshing is not supported within Emesent Aura.

The Selection Tools in the Main Toolbar work across multiple point clouds. If you 

have two point clouds selected at the same time, you can select points in both. To 

select/unselect multiple files, hold down the Ctrl key then click on each file you 

want to select or unselect.
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5.5 GCP Workflow

The Emesent Knowledge Base article Working with Point Clouds - GCP Workflow walks you through the 

entire GCP workflow step-by-step, and links to the complementary video Best Practice for Automated 

Ground Control Points.

5.6 Merge Workflow

Aura’s Merge workflow uses a SLAM-based algorithm to non-rigidly align multiple datasets into a single, 
seamless point cloud output. Merging multiple point clouds improves efficiency, accuracy, and usability 

especially for complex, multi-scan projects. It also ensures consistent alignment of scan data, resulting 

in a high-quality deliverable.

Aura supports merging a combination of georeferenced and non-georeferenced scans. Each scan must 

be individually processed before merging.

The merge process outputs individual .laz  files for each scan. These files are aligned using the SLAM 

algorithm and georeferenced if applicable. The individual .laz  files can then be combined within Aura 

to produce a unified point cloud.

The following steps outline the merge workflow in Aura.

https://knowledge.emesent.com/gcp-workflow-in-aura
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5.6.1 Prepare for the Merge

5.6.1.1 Ensure Overlap

During capture you need to include a reasonable amount of overlap between scans to provide 

sufficient information for alignment. A rough guide is to have one-third of each dataset overlap with the 

next.

5.6.1.2 Consider System Resources

Although there is no strict limit to the number of files you can align, processing demand will increase 

with each added dataset. Avoid merging point cloud files that add up to more than your available RAM. 

Use subsampled point clouds to reduce computational load.

5.6.1.3 Scan Requirements for Merging

Before merging, each scan must be processed in Aura:

Georeferenced Scans (RTK):

Must be processed with the correct device under Georeferencing mode in Processing 

Settings.

Set the base coordinate reference system to match the coordinate system used for RTK 

corrections.

Georeferencing must be Enabled in Processing Settings.

Non-georeferenced scans:

Must have Georeferencing mode set to None in the Processing Settings.

Drone RTK and GCP scans:

Can be merged, but georeferencing will not be retained. Set georeferencing to None

before merging.

Scans processed in Aura versions earlier than 1.10:

You can merge vehicle RTK, backpack RTK, and non-RTK scans together. RTK scans 

will help improve the alignment of non-RTK scans in areas where they overlap.
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•

May default to GPS for non-georeferenced scans. Reprocess these scans in Aura 1.10 or later 

with georeferencing set to None.

Mixed scanner models:

Merging scans captured using different Hovermap models (e.g. ST and ST-X) is supported, 

but ensure compatible firmware and Aura versions were used.
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5.6.2 Step 1. Configure Your Merge Job

Open Emesent Aura and click Process Scan in the top-left corner.

Select the Merge workflow in the Configure New Scan Job panel.

Click Add Datasets, then click Add next to Add dataset folder. (e.g. ScanJob123)

ScanJob123/

├── Output/
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4.

5.

Wait for Aura to automatically detect and list the available files.

Repeat steps 3–4 to add all scans you want to merge.

Do not select the Output folder. Ensure you select the main scan folder.
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5.6.3 Step 2: Choose an Alignment Base for Preview

For all merge types (Non-georeferenced scans, RTK, RTK + Non-RTK):

In the Alignment Preview File column, select any scan to use as the alignment base.

This file is used for preview purposes only and does not affect the final output. If available, Aura 

will default to a subsampled version.
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5.6.4 Step 3: Configure Apply Overrides (Optional)

For all merge types (Non-georeferenced scans, RTK, RTK + Non-RTK):

Configure scan-specific settings, such as defining exclusion zones or trim data.

For RTK Merges and RTK + Non-RTK Merges:

Verify that RTK scans have their georeferencing method and GNSS receiver type correctly 

assigned. Aura will apply these automatically.
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5.6.5 Step 4: Select a Reference Scan (Optional)

For Non-georeferenced scans (Non-RTK) Merges:

You can choose one scan to act as the reference scan. This scan will be locked in place, and all 

other scans will align to it.

For RTK Merges and RTK + Non-RTK Merges:

Reference scans are supported for merges involving RTK scans. Proceed to Step 5.

If a reference scan is not selected, Aura will perform pairwise alignment

between all point clouds. This increases computational complexity and may 

extend processing time.
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5.6.6 Step 5: Configure Processing Settings

For all merge types (Non-georeferenced scans, RTK, RTK + Non-RTK):

Define the location and name for the merged output.

Adjust any desired settings using the general merge or output options, as outlined in the Aura 

User Manual, Section 3.3 – Process Tab.

For RTK Merges and RTK + Non-RTK Merges:

Set processing settings:

Set the Base Coordinate Reference System to match the original horizontal CRS used 

during scan acquisition (e.g. EPSG:4326 – WGS 84).

To manually enter a full PROJ string, enable Custom base CRS.

Enable Reprojection (optional) if you want to transform the output into a different 

coordinate system. Define the Target Coordinate Reference System by selecting the 

desired horizontal and vertical CRS values.
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5.6.7 Step 6: Proceed to Alignment

For Non-georeferenced scans (Non-RTK) Merges:

Proceed to Step 7: Review and Manually Align.

For RTK Merges and RTK + Non-RTK Merges:

Proceed to Step 7: Review and Manually Align.

For RTK Merges

If setup is correct, Aura will notify you that no manual alignment is necessary and you can skip 

manual alignment and start processing.
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5.6.8 Step 7. Review and Manually Align (If Required)

Aura’s SLAM algorithm relies on overlapping features between scans to perform a merge. When 
georeferencing is unavailable or inconsistent across datasets, manual alignment is required to provide 

an initial position estimate. This reduces drift and improves the overall quality of the merged point 

cloud.

Click Load Scans to load all selected point clouds into the viewer.

Each scan is automatically assigned a unique color to assist with differentiation and 

alignment.

To add or remove datasets from the current merge job you can click Edit Point Clouds 

Selected.

Align scans manually using the Translate and Rotate tools. Start with Top View to position 

and rotate scans horizontally, then switch to Front View to adjust them vertically.

•

•

Manual alignment is required in the following scenarios:

Merging scans without georeferencing (e.g. Non-RTK)

Merging georeferenced and non-georeferenced scans together (e.g. RTK + 

Non-RTK)

Aura will attempt to merge scans even if they are misaligned, either horizontally 

or vertically. This can result in a skewed or inaccurate final output. Always verify 

alignment before continuing.



Emesent Aura User Manual

Release date: 22 Apr 2025
Revision: 3.4

91

Figure 2 Align horizontally using the Translate and Rotate tools.
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Figure 3 Align Vertically using Translate

Click Reload Scans in the Configure New Scan Job panel to reset a scan’s 
position.
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1.

You are now ready to begin processing.

Click Start to begin the merge.

Start button not visible

If the Start button is hidden, click the Configure New Scan Job panel at the 

bottom of the window to reopen the Processing Scan panel and access the Start

button.
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5.6.9 Step 9. View and Combine Your Datasets

Once processing is complete, Aura outputs a .laz  file for each scan. These files are stored in the 

directory specified in Step 1. They are aligned using the SLAM algorithm and georeferenced, if 

applicable.

You can now combine these individual .laz  files within Aura to produce a unified point cloud. The 

outputs are grouped and displayed in the Merge Complete panel.

Click View under the Merge Complete panel to inspect each output dataset individually.

Minimise the Merge Complete panel to access the Visualize tab.
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5.

(Optional) Adjust the color of each point cloud in the Visualize tab to compare and validate the 

alignment and quality of the merged scans.

Select multiple datasets by holding Shift and clicking on each desired dataset.

Open the Project menu and select Save As to save the combined dataset as a single point 

cloud.



Emesent Aura User Manual

Release date: 22 Apr 2025
Revision: 3.4

96

1.

2.

5.6.10 To combine datasets at a later time:

Navigate to the Visualize tab.

Click Add to load previously processed .laz  files.
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3. Repeat steps 3–5 above to compare, validate, and save the combined dataset.
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5.6.11 (RTK Only) View the Combined Accuracy Report

After processing an RTK merge, each scan generates a .csv  accuracy report. These reports are stored 

in the output folder of each individual scan. To load multiple reports into Aura and generate a 

combined accuracy report, follow the steps below.

Open the Merge Complete menu in Aura.

This appears automatically after processing, or can be accessed by clicking the Merge 

Complete bar.

Click View on the right-hand side of any metrics.csv  accuracy report to open it.
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3. Click + CSV in the report window to open Windows Explorer, then navigate to and select any 

additional .csv  accuracy reports to include.
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4. Select the Combined Report tab to view the merged accuracy data.
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5.6.12 Colorize and/or Extract 360 images (Optional)

After merging, you can colorize your point clouds using camera imagery by following the instructions in 

the Aura User Manual - Colorization Workflow.

5.6.13 Merge Compatibility Summary

Scan Type Merge Supported Georeferencing Retained After 

Merge

Vehicle and Backpack RTK ✅ ✅

Drone RTK ✅ ❌

GCP ✅ ❌

5.6.14 Troubleshooting

Issue Cause Solution

Merged RTK scans 

aren’t georeferenced
Apply Overrides wasn’t used Select a georeferencing mode using 

Apply Overrides before merging scans.

RTK scans still 

require manual 

alignment

Georeferenced scan not set as the 

preview file

Select the RTK scan as the Alignment 

Preview File (satellite icon).

Aura isn't detecting 

my scan files

Wrong folder selected or scans not 

processed

Select the offload folder with .bag  files, 

not the Output folder
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5.7 Colorization Workflow

Emesent’s colorization feature allows you to augment your point clouds with true color, providing 
additional context for visualization and analysis. Colorization works by merging Hovermap’s LiDAR scan 
data with video recorded by a GoPro that has been mounted to Hovermap.

The basic process for colorization is as follows.

5.7.1 Step 1: Collect your data

Go to Working with colorization for more information on how to set up your Hovermap and 

GoPro for colorization and colorization-specific scanning techniques.

Check that you have everything necessary to create a colorized point cloud:

An updated license dongle with a valid Colorization license.

Your Hovermap scan folder (containing raw data from Hovermap).

A GoPro video file (an MP4 file contained within the scan folder).

https://4999118.fs1.hubspotusercontent-na1.net/hubfs/4999118/Customer%20Success/Knowledge%20Base/User%20manuals%20and%20instructions/INSTR-019%20-%20Working%20with%20colorization%20-%201.0.pdf
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5.7.2 Step 2: Configure your scan job

Open Emesent Aura. Make sure you have an active Colorize license.

In the Process tab, click Process Scan.

In the Configure New Scan Job panel, select the Colorize workflow.

Click Add Dataset.

In the dialog box that displays, browse for the folder that contains the point cloud to be colorized. 

Ensure the scan has been processed and the .mp4 file or .360 file is in the same directory. If the video 

file is detected, it will appear in the Video file(s) column (multiple video files will appear if detected 

depending on the scan duration).

To colorize a dataset, the serial number of the camera used to create the dataset 

must match the serial number in the Hovermap calibration file.
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If there are multiple output folders in the selected scan folder, click the arrow beside the output 

folder then select from the list.

In addition, in the Scan File column, the non-georeferenced output is selected by default. If you 

want to colorize a georeferenced point cloud, click the arrow beside the scan file then select the 

file labeled Scan Processed with Landmarks.

Once you have selected the point cloud to colorize. click Save.

In the Location field, enter the preferred name for the output folder. Emesent Aura will create 

this folder, which stores all the processed results and data, as a child directory within the raw 

point cloud folder.
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1.

2.

3.

4.

Select the processing profile to use. Refer to the Processing Profiles section for more information 

about which profiles to use and how to create a custom profile.

Define colorization settings - refer to the Creating a Custom Mask section for instructions on 

creating your own image mask.

5.7.3 Step 3: Start processing

Click Start to begin processing. The panel will show a progress bar showing how far along you 

are in your processing job. In addition to the progress bar, the elapsed time of the processing job 

is shown to the right.

When prompted, click Review Frames.

In the file explorer window, manually delete any unwanted frames from your video.

Once the unwanted frames are removed, return to Emesent Aura and click Resume.

If a failure occurs during processing, the Retry buttons becomes available. Click 

this button to attempt to process the current job from the last successful stage.
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5.7.4 Step 4: View your final output

Once processing has been completed, click Open folder to view the output folder or View to 

display your colorized point cloud in the Viewport.

Click Close to remove the scan information from the processing space.

The image frames used during colorization can be exported with the colorized point cloud. You 

can find them in the Intermediate files > frame_extraction > frames folder. This folder also 

contains 3 CSV files with pose information in formats compatible with export to Pointerra, 

Cintoo, Bentley, and Prevu3D.
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5.7.5 How do I colorize a Merged Point Cloud?

Colorizing a Merged dataset involves Merging the datasets first, then colorizing each individual scan as 

a separate Colorization processing job as illustrated in the diagram below.

Below are the steps to colorize a Merged dataset:

Merge the dataset by following the Merge Workflow before starting colorization.

Select the Colorize workflow in the Processing Tray.

Add the scan folder that contains the merged dataset output.

Set the merge output folder as your scan folder.

Select the first scan file to colorize.
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6.

7.

8.

9.

10.

Select the video files that correspond to the selected scan file.

Save the configuration.

Adjust processing settings as required by following the Colorization Workflow Guide.

Start processing.

Repeat steps 5–9 for each additional scan file, selecting the appropriate scan and video files for 
each.

5.8 Extract 360 Images Workflow

The plug-and-play 360-degree camera accessory for Hovermap, combined with seamless processing in 

Aura, enables the easy capture, registration, and export of 360 panoramic images.

Please refer to the Knowledge Base asset: 360 Panoramic Image Guide (includes video) for instructions.

https://knowledge.emesent.com/360-panoramic-image-guide
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5.9 Moving Object Filtering

Identifying moving objects within a point cloud is done by estimating statistical scores for points based 

on their temporal and spatial relationship to their neighborhood. These scores provide a quantitative 

measure of the likelihood that a point belongs to a moving object, enabling the Moving Object filter to 

differentiate between dynamic and static elements in the point cloud.

This feature can be applied to your point cloud as a cleaning filter or from the Processing Settings as 

part of Emesent Aura’s processing workflow.

5.9.1 Using the Moving Object Filter

Load your point cloud using any of the following options:

In the top-left menu, click the Project Menu icon then select Open from the popup menu.

Drag and drop your file directly into the Viewport.

Go to the Visualize tab then click Add next to the Point Clouds section.

From the Main Toolbar, click the Cleaning Filters icon then select Moving object filter.

In the Moving Object Filter dialog box, configure the following parameters as required.

Motion level: Detects movement over 5 second intervals. The higher the value, the lesser 

moving points are selected.
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4.

Distance: The maximum distance for recovering fixed points. The higher the value, the more 

points are retained. A value of 1 to 2 cm is recommended for most scans.

Under Point outlying, choose whether the outlying points will be deleted or just selected. If you 

choose Select, the selected points will show in sepia/gray color.

Once the points are selected, running the filter again will require the points to be 

cleared by pressing the ESC key. The algorithm only takes into account the whole 

cloud if no points are selected.
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5. Once satisfied with the selection, press the DELETE key on your keyboard to remove the points.

5.9.2 Applying Motion Filtering from Processing Settings

The filter can also be accessed by enabling Motion filtering from the General tab in Processing 

Settings. The filter will default to settings based on the profile and detected hardware in the raw scan 

directory.

•

•

The filter is disabled by default to avoid accidentally removing some 

important features with default thresholds including GCP disks if they are 

not scanned well.

An aggressive setting may lead to ‘holes’ on object surfaces in the resulting 
point cloud.
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1.

5.10 Creating a Custom Mask

When processing a dataset with 360 video for image extraction or colorization, one of the essential 

steps is applying a mask to the extracted frames. This is because there may be areas in the frame that 

you do not want to show. Emesent Aura comes with several pre-defined masks that you can use for this 

purpose but you can also create your custom mask in case none are suitable for your dataset.

To create a custom mask

The following process is demonstrated using GIMP (a freely downloadable editing software). However, 

you can utilize any third-party image editing software, as the techniques discussed here are applicable 

across various platforms.

Run an Extract 360 images workflow with Image masking turned off.

If you have a large video, running image extraction once on a small subset of data 

is recommended. You can achieve this by setting a high Frame Extract Interval

(e.g. Distance: 20 and Angle: 90) or specifying a low Video time end setting (e.g. 

10 seconds). For Aura 1.5 and earlier versions, you can also use a Frame Interval

of 250.
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2.

3.

4.

Navigate to the extracted frames folder once the frame extraction process is completed.

Select a frame you want to create a mask for and open it in GIMP.

Adjust the display to ensure the image fits your screen properly.
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5.

6.

Start with an existing mask instead of creating one from scratch. Open the folder containing the 

predefined masks by navigating to Program Files > Aura > Aura> Plugins > 

EmtProcessWorkflows > Content > ProcessWorkflows > ImageMasks.

Select a suitable mask from either the colourise or FrameExtract folder then drag this mask 

onto your current image in GIMP. It will appear as a new layer.
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7.

8.

Use the Fuzzy Select Tool (aka Magic Wand) and click on the black area of the mask layer to 

select it.

In the Layer panel on the right, every layer in the image appears as a thumbnail. The upper layer 

in the list is the first one visible. Click the Eye icon before the mask layer to hide the mask.
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9.

10.

Notice that the selected mask area is visible on top of the image.

Use the Free Select Tool to add or refine areas to the mask as needed. Press the Enter key to 

add the area to the current selection.

Keep the frames folder handy and add more frames if necessary. Review each added frame, 

adjusting the mask to ensure proper coverage, especially around challenging areas like hands or 

cables.

Make sure the Mode is set to Add to the current selection. You can do this by 

clicking on the second mode icon or pressing the Shift key while selecting.
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11.

12.

Ensure that the active background color is set to black.

Once satisfied with the mask, go to the Layer panel and select the base layer containing the 

extracted image.
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13. Press Delete on your keyboard.
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14.

15.

Go to Select > Invert then press Delete again. The entire image is now black.

Click the Bucket Fill Tool. Ensure the active foreground color is white.
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16.

17.

Click the top area to fill it with the active foreground color (white).

Go to File > Export As. Save the mask in PNG format to avoid the lossy compression issues 

associated with JPG files.
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18.

19.

1.

2.

3.

Click Export.

Close GIMP and return to the Emesent Aura.

To add the custom mask in Aura

Run a Colorize or Extract 360 images workflow again.

Click Processing Settings.

In the Colorize or Extract 360 images tab, enable Image masking.

If using Emesent Aura version 1.5 or earlier, change the pixel format to 8bpc RGB.
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4.

5.

6.

In Mask template, click the + icon.

Enter a name for the custom mask, click Create then browse for the newly created mask.

Click Save to finish adding the custom mask to Emesent Aura.
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1.

2.

3.

4.

5.

6.

5.11 Reprojecting your Point Cloud

Reprojection in Emesent Aura is an automated workflow that allows for RTK scans to be processed with 

the correct coordinates by simply selecting the target coordinate reference system (horizontal) and 

converting from ellipsoidal height to orthometric height using a GEOID model (vertical). This can be 

done via Processing Settings when processing raw data or Export reprojection from the Project 

menu if exporting a georeferenced point cloud.

5.11.1 Processing and Reprojecting Raw Point Cloud Data

Open Emesent Aura and in the Process tab, click Process Scan.

In the Configure New Scan Job panel, select the Process workflow.

Click Add Dataset then browse for the folder that contains the raw RTK data to be processed. 

Select that folder.

You will be prompted once RTK data is detected in your dataset. Toggle on Use RTK data.

In the Location field, enter the preferred name for the output folder. A subfolder is created, 

which stores all the processed results and data.

Click Processing Settings. Under Georeferencing in the General tab, select the RTK device and 

GNSS receiver used to capture the RTK data.
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7. Under Base coordinate reference system, set the Coordinate Reference System in which the 

data was originally collected. This information is essential for accurate transformations and 

reprojections to the target CRS.

Alternatively, toggle on Custom base coordinate reference system to enter a project string that 

describes the desired geodetic coordinate reference system.

For optimal results, ensure that the Georeferencing mode and GNSS receiver 

type match the hardware used during data collection. While the resulting point 

cloud remains usable, the accuracy may be affected.
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8.

9.

1.

2.

Toggle on Reprojection then select the appropriate Horizontal and Vertical coordinate 

reference systems.

Horizontal: Reproject to a different map projection or coordinate system.

Vertical: Convert from ellipsoidal height to orthometric height using a GEOID model.

Alternatively, toggle on Custom target coordinate reference system to enter a project string 

that describes the desired target coordinate reference system.

Click Save.

5.11.2 Reprojecting a Processed Point Cloud

Open Emesent Aura and go to the Visualize tab.

Load the processed point cloud or trajectory you want to reproject.
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3.

4.

Click the Project menu icon then select Export reprojection.

In the Export Reprojection dialog box, click Edit Source CRS. This step is optional as Emesent 

Aura automatically detects the CRS of the input data. However, editing may be necessary if the 

CRS is incorrect or you are working with data from multiple sources that require a specific CRS.

Refer to the Context Panel on the right of the screen to see the projection information of the 

current point cloud.
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5.

6.

7.

8.

Select the target Horizontal and Vertical coordinate reference systems or toggle on Custom 

target coordinate reference system to enter a project string that describes the target CRS.

Enable Reproject trajectory to apply reprojection to the trajectory data associated with the 

point cloud, ensuring that any movement or path data is aligned with the target CRS.

Enable Replaced loaded point cloud with exported reprojection to replace the currently 

loaded point cloud with the newly reprojected version.

Click Save. The results are saved in the same output folder as the original point cloud.
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•

•

•

•

•

•

•

6. Glossary

Term Definition

Constellation A collection of targets and landmarks, and the way that they sit in 

relation to each other. A constellation is associated with the point 

cloud, but is separate from it.

EDL Eye dome lighting. Improves depth perception by shading the outline 

of points, accentuating the shape of each object.

File formats supported LAS: Contains the point cloud. Industry-standard file format for 

LiDAR data.

LAZ: A compressed LAS file.

E57: A compact file format used for point cloud storage. Only 

E57 files generated by Emesent Aura are supported.

SLAZ: A Streaming LAZ file. Instead of loading the entire point 

cloud, Emesent Aura only streams images of the portion of the 

point cloud that you are looking at, “discarding” the rest. This is 
an optimized way of looking at scans, which means a faster 

loading time than the usual LAZ datasets.

XYZ: A widely-supported point cloud format. In the context of 

Emesent Aura, XYZ files appear in the Entity panel as a 

trajectory point cloud, showing Hovermap’s path.

PLY: Standard mesh file format.

YAML: A configuration file attached to a LAS file. In the context 

of Emesent Aura, a YAML file is the constellation of GCPs. The 

file superimposes targets over your point cloud. The default 

name is constellation.yaml.

GCPs Ground control points. GCPs are points with known geographical 

coordinates.
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Term Definition

Intensity Measures how much of the emitted laser signal is returned. It is based 

mostly on the reflectivity of the object struck by the laser, but can also 

be affected other factors, such as the scan angle, surface composition, 

roughness and moisture content.

Landmark The GPS coordinates entered in the CSV file. These are referred to as 

landmarks in Emesent Aura.

Mesh A 3D model consisting of vertices, faces and edges.

Point cloud A collection of individual points plotted in a 3D space.

Scalar field Scalar fields give you a single, measurable value for each point in your 

point cloud. Because each value is associated with one point, it is 

possible to show the point cloud using a color gradient that is based 

on these measurable values.

These values also allow you to apply filters to your point cloud.

SLAM Simultaneous localization and mapping. SLAM technology runs in real-

time to allow Hovermap ST to create a map of its environment, while 

at the same time working out its position, orientation, and speed 

within that environment.

Target The reflective disc aligned to a GPS coordinate.

Transform Records the orientation differences between point clouds after you 

have done a manual alignment. Emesent Aura works in the 

background to record this automatically. The transform then tells the 

processing job what to do to align the scans properly.

Translate To move or shift the point cloud along an axis.

Units All units in Emesent Aura are in meters.
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7. Support

The Emesent Customer Support team is available to assist at every stage of your experience. For 

support, visit the Customer Portal.

The following services are available through the portal:

Submit a support request for technical assistance, report an incident, or suggest a new feature

Download firmware and software updates from the Software Downloads page

Access user guides, training resources, tutorials, and troubleshooting content in the Knowledge 

Base

Access guided training to take your skills further in Emesent Academy

When submitting a request, provide as much detail as possible to assist the 

support team in resolving the issue efficiently.

https://emesent.com/customer-support/
https://emesent.com/portal/software-downloads/
https://knowledge.emesent.com/
https://academy.emesent.io/register?tenancyId=2
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